
Design & Computation Manager Programs 
Geopak's Design & Computation Manager uses Geopak 3 port criteria program files or 3PC files
as they are commonly called and Microstation programs to produce special graphic displays or to
perform special functions.

 This document contains program descriptions and workflows for these special programs listed in
the order as they appear in the Design & Computation Manager. 
These programs can be activated in two ways. 

If you are running in the dialog mode with the expanded D&C Manager window then double 
click on the item with Design mode active. 

If you are running D&C Manager window in the toolbox mode then just click on the Execute 
Design Keyin button 



Drafting Standards 
Tools 
Set Text 
D&C location: Drafting Standards>Tools> Set Text 
Microstation Macro Program: SetText.ba 
Description: 
This application sets text size, line spacing for multiline text and element weight  based on active 
scale and the desired final plot size of the text. 

This macro can also be activated from the Microstation drop down menu TDOT>Text>Set Text 
Parameters by Active Scale or by using the keyin MACRO SETTEXT. 
Special Requirements: 
None. 
Usage: 
Step 1. In D&C manager activate Set Text. The Set Text Parameters by Active Scale 

dialog appears. Defaults that come up are English units and a 0.100 plot text size. The 
active scale value is read from the active scale currently set in the design file. 

Step 2.	 Make settings as needed: 
Set Units to English or Metric. 
Set Active Scale to an alternate value if needed. If changed this will reset the active 
scale in the file. This should be set to the scale at which the text graphics are to be

plotted.

Choose the Plot Text Size desired from the standard text size list.


Step 3.	 Once settings are made click on the Set Text Size, Weight, Line Spacing button and 
the dialog will disappear.  Text parameters are set in the file based on the dialog 
settings. Any Microstation text command can now be used to place text. 



Earthwork Text 
D&C location: Drafting Standards>Tools> Earthwork Text 
Geopak 3PC Program: ew__labels.x 
Microstation Macro Program: ew_labels.ba 
Description: 
These two programs work together to add earthwork text prefixes & suffixes to the earthwork
text file used when setting up cross section sheets to annotate earthwork areas. The Microstation
macro provides the dialog interface and the Geopak 3PC does the file processing. 

Special Requirements: 
An earthwork text file with end area values must already be created using Geopak's Earthwork 
calculation program. 

Usage: 

Step 1.	 Generate an earthwork text file with end area values using Geopak's Earthwork 
calculation program. Note which soil data types are placed in which columns. 
Example: earth cut in column 1, earth fill in column 2, rock cut in column 3, etc. 

Step 2.	 In D&C manager activate Earthwork Text. The Add Earthwork Text Prefixes & 
Suffixes dialog appears. 



Step 3.	 In the dialog click on the Files button to go find the Sheet Quantities Earthwork 
Text File created in step 1. Key in a new file name for the New Sheet Quantities 
Earthwork Text File to be created or if replacing a previous version click on it's 
Files button to grab the filename previously used 

Step 4.	 In the dialog fill in the appropriate prefixes (and suffixes if desired) for the soil data 
types in each column of the original file. These cannot include spaces. If entered they 
are ignored. For a gap between words key in an underbar instead of a space. Include 
soil types in prefix as needed such as EARTH_CUT= and ROCK_CUT=. 

Step 5.	 Once the dialog is filled in for all columns of data from the original file click on the 
OK button. The new file is generated. When the cross section sheets are set up with 
Geopak then the new earthwork text file should be specified so that earthwork areas 
are annotated clearly. 



Move Raster 
D&C location: Drafting Standards>Tools> Move Raster 
Microstation Macro Program: moveraster.ba 
Description: 
This application moves the active raster attachment by a user given datum adjustment factor. 

Raster images which are geo-referenced to the Tennessee state plane coordinates will come near
our projects but due to the datum adjustment factor on coordinates they will usually be off some.
This program will take that value and move the raster attachment to align properly with project
data. 

This macro can also be activated from the Microstation drop down menu TDOT>Move Raster 
by Datum Adjust or by using the keyin MACRO MOVERASTER. 

Special Requirements: 
Raster Manager must be open with the raster image to be moved highlighted in the dialog. 

Usage: 

Step 1.	 In Microstation activate File>Raster Manager. Highlight the attachment to be 
moved. 

Step 2. In D&C manager activate Move Raster. Keyin the datum adjustment factor for the 
project area. Once that is set click on Go Move Raster. 



Step 3. The user is then prompted to Identify any point near project. 

Data point in the project area and the raster attachment is moved to overlay the 
project data correctly. 



Roadway Horizontal Alignments 
HA Points 
D&C location: Drafting Standards>Roadway Horizontal Alignments>HA Points 
Geopak 3PC Program: draw_horiz_points.x 
Description: 
Uses text symbol characters to mark all points on roadway horizontal alignments. Curve PIs also
include short tangent lines with the PI symbol. Multiple alignments can be processed. As each
alignment is completed an option to do another is offered. 

Special Requirements: 
All horizontal alignment graphics must be visible in View Window #1. 

Usage: 

Step 1.	 Using D&C item HA Roadway display the horizontal alignment(s). 

Step 2.	 In View Window #1 fit view so that all graphics are displayed in the view. If needed 
turn on level 31. 

Step 3.	 In D&C manager activate HA Points. The initial warning message is displayed, Click 
OK to go on. 

Step 4. You are then prompted for a job no. Key that in and click OK. 

Step 5. You are then prompted for the scale. Key that in and click OK. 



Step 6. You are then prompted for the chain name. Key that in and click OK. 

Step 7. The 3PC processes the chain and places graphics. Finally an option to process another 
chain is offered. Click OK to process another chain or click Cancel to exit. 



Roadway Vertical Alignments 
VA Points 
D&C location: Drafting Standards>Roadway Vertical Alignments> VA Points 
Geopak 3PC Program: draw_vert_points.x 
Description: 
Uses text symbol characters to mark points & labels VPCs & VPTs with station & elevation on
roadway vertical alignment curves as well as the begin and end points of the vertical alignment if
they are not curve points. 

Special Requirements: 
All alignment graphics must be visible in View #1 and a Geopak profile cell must be present.
The Geopak profile cell must be based on a station within the chain, it cannot be set on a station 
off the chain. If set this way an invalid profile subroutine error will occur. 

Usage: 

Step 1.	 Using D&C item VA Roadway display the vertical alignment. 

Step 2.	 In View Window #1 fit view so that all graphics are displayed in the view. If needed 
turn on levels 31 & 63. 

Step 3.	 In D&C manager activate VA Points. The initial warning message is displayed, Click 
OK to go on. 

Step 4. You are then prompted for a job no. Key that in and click OK. 

Step 5. You are then prompted for the chain name. Key that in and click OK. 

The 3PC reads the proposed profile and places point symbols with station & elevation 
text labels at VPCs, VPTs and begin and end points that are not curve points. 



Existing Profiles 
Profile Grid 
D&C location: Drafting Standards>Existing Profiles> Profile Grid 
Geopak 3PC Program: draw_profile_grid.x 
Description: 
Draws a working profile grid for a roadway's profile area. This is not intended for final plans
production but rather as a working aide while developing proposed vertical alignments, drainage
structures, etc. It also allows for plotting of profile rolls for longer projects. This program does
have numerous prompts but in doing so allows the user total control on the extent of the grid to
be placed. 

Special Requirements: 
Profile's lower left reference origin location must be visible. This is the location which
corresponds to the minimum elevation and beginning station of the desired profile grid. 

Usage: 

Step 1.	 In View Window #1 set the view so that the lower left reference origin location of the 
profile area is visible in the view. 

Step 2.	 In D&C manager activate Profile Grid. You are prompted for a Horizontal Scale. 
Key that value in or take the default value of 50 and click OK. 

Step 3. You are then prompted for a Vertical Scale. Key that value in or take the default 
value of 5 and click OK. 

Step 4. You are then prompted for the Minimum Elevation. Key that in and click OK. 



Step 5. You are then prompted for the Maximum Elevation. Key that in and click OK. 

Step 6. You are then prompted for the Beginning Station. Key that in and click OK. Note 
that the "+" symbol in the station value is optional. 

Step 7. You are then prompted for the Ending Station. Key that in and click OK. 

Step 8.	 Finally you are prompted for the Reference Data Point. Snap to the reference 
location which corresponds to the minimum elevation and beginning station given 
previously and Data Point. 



The 3PC generates the profile grid based on your given control values on level 62. 



Ex SA/ST System 
D&C location: Drafting Standards>Existing Profiles>Ex SA/ST System 
Geopak 3PC Program: draw_cb.x 
Description: 
Draws existing storm and sanitary sewer catch basins, drop inlets & manholes as well as
connecting pipes on profile using plan view graphics. Includes annotation of structures and
pipes. Produces error log for missing data, etc. Used by Survey personnel. 

Special Requirements: 
All graphics must be in a Microstation selection set prior to running the program and a Geopak 
profile cell must be present. 

The use of this application requires that field data be collected in a certain manner.  Please note 
that some data can be added or corrected in the office if the field crew does not take all shots 
required for the 3PC program to run. 

When a point is set in the field and coded:  XCB, XDI, XMHSTS or XMHSAS this sets the top 
invert of the structure.   At this time another point is set using XBOT code and the elevation is 
adjusted to the bottom invert of the structure. 

For pipe coding all pipes need a FROM / TO field shot, using ?STS or ?SAS. Doing this will 
place the correct custom line style for the existing pipe and place an XINV cell at each end of all 
runs of pipe. 

If there is a run of pipe that begins or ends outside the limits of the horizontal alignment this run 
of pipe needs to be adjusted in the office by placing a XINV cell on the pipe run within the limit 
of the alignment and setting a break in the existing pipe line at that location. To get this done: 

1.	 On level 30 draw a Microstation line crossing the existing run of pipe within the

alignment.


2.	 Draw another Microstation line from exist. invert to exist. invert on the existing pipe. 

3.	 Temporarily turn off the level of the existing pipe. 

4.	 Using Microstation extend to intersection the second line drawn with the first line placed. 

5.	 Place a XINV cell at the new end of this line. 

6.	 Delete the two lines that you placed to locate the new XINV cell. 

7.	 Turn the level of the existing pipe back on 

8.	 Add a break in the existing pipe line at the location of the new XINV cell just placed 
using Microstation partial delete snapping to the cell location each time to make a zero 
length break in the pipe line. 



Usage:


Step 1.Using Microstation's Selection Set tool add all plan view graphics to a selection set..


Step 2.	 In D&C manager activate Ex SA/ST System. The initial warning message is 
displayed, Click OK to go on. 

Step 3. You are then prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

Step 5. If errors are encountered then an error log file named draw_cb.log is created and the 
user is notified with a message prompt.  Click on OK to dismiss this message. 



Step 6. If an error log was generated use any ASCII text editor to review errors. Make 
corrections in plan view graphics as needed, delete any invalid graphics placed 
previously on the profile and reprocess. 

You do not have to re-do the entire project. This can be done on localized areas by 
limiting the plan view graphics which are placed in the selection set prior to 
activating the 3PC program. 

Step 7. Edit or move text on profile as required. Add CB, MH and DI numbers if a table is 
used. 



BMonPro 
D&C location: Drafting Standards>Existing Profiles> BMonPro 
Geopak 3PC Program: bmonpro.x 
Description: 
Draws and labels benchmarks and control points with annotation from plan view on to profile.
Used by Survey personnel. 

Special Requirements: 
All graphics must be in a Microstation selection set prior to running the program and a Geopak 
profile cell must be present. 

If a benchmark or control point is not within the limit of the horizontal alignment the program 
will generate an error file noting those. 

After running the program check or input the elevation on the profile text.  At this time remove 
any points from the profile that you do not want shown there. 

Usage:


Step 1. Using Microstation's Selection Set tool add all plan view graphics to a selection set..


Step 2.	 In D&C manager activate BMonPro. The initial warning message is displayed, Click 
OK to go on. 

Step 3. You are then prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 



Step 5. If errors are encountered then an error log file named bmonpro.log is created and the 
user is notified with a message prompt.  Click on OK to dismiss this message. 

Step 6. If an error log was generated use any ASCII text editor to review errors. Make 
corrections in plan view graphics as needed and reprocess. 

You do not have to re-do the entire project. This can be done on localized areas by 
limiting the plan view graphics which are placed in the selection set prior to 
activating the 3PC program. 

Step 7. If no benchmarks are found then a message is given indicating that situation 
otherwise the final completion message is given. Click on OK to dismiss this 
message. 

Step 8. Edit/check text on profile as needed to indicate the correct elevation. Any points 
which are not desired on the profile should be deleted. 



OHonPro 
D&C location: Drafting Standards>Existing Profiles> OHonPro 
Geopak 3PC Program: ohonpro.x 
Description: 
Draws and labels low wire crossings with annotation from plan view on to profile. Used by
Survey personnel. 

Special Requirements: 
All graphics must be in a Microstation selection set prior to running the program and a Geopak 
profile cell must be present. 

The low wire crossing shot needs to be on the proposed centerline if it is not the program will not 
run. After running the program the user must edit text annotation on the profile to list the 
temperature, crossing wire types and numbers located at each location. The elevation shown is 
for the lowest wire only. 

Usage: 

Step 1.	 Using Microstation's Selection Set tool add all plan view graphics in View #1 to a 
selection set.. 

Step 2.	 In D&C manager activate OHonPro. The initial warning message is displayed, Click 
OK to go on. 

Step 3. You are then prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 



Step 5. If errors are encountered then an error log file named OHonPRO.log is created and 
the user is notified with a message prompt.  Click on OK to dismiss this message. 

Step 6. If an error log was generated use any ASCII text editor to review errors. Make 
corrections in plan view graphics as needed, delete any invalid graphics placed 
previously on the profile and reprocess. 

You do not have to re-do the entire project. This can be done on localized areas by 
limiting the plan view graphics which are placed in the selection set prior to 
activating the 3PC program. 

Step 7. If no overhead wire crossings are found then a message is given indicating that 
situation otherwise the final completion message is given. Click on OK to dismiss 
this message. 

Step 8. Edit text on profile as needed to indicate the temperature, crossing wire types and 
numbers at each crossing location. 



Survey Control 
Cntrl Pt Table 
D&C location: Drafting Standards>Survey Control>Cntrl Pt Table 
Geopak 3PC Program: draw_contrl_pt_table.x 
Description: 
Builds control point table for placement in plan view. Used by Survey personnel. 

Special Requirements: 
All graphics must be in a Microstation selection set prior to running the program. 
If a benchmark or control point is not within the limit of the horizontal alignment the program
will generate an error file noting those. 
After building the control point table with this program it is necessary to edit the data to show
point numbers, coordinate decimals to 4 places and elevations for benchmarks. 

Usage: 

Step 1.	 Using Microstation's Selection Set tool add all plan view graphics to a selection set.. 

Step 2.	 In D&C manager activate Cntrl Pt Table. You are prompted for a job no. Key that 
in and click OK. 

Step 3. You are then prompted for the chain name. Key that in and click OK. 

Step 4. You are then prompted for a Data point for the table location in the plan view area. 



Step 5. If errors are encountered then an error log file named control_table.log is created and 
the user is notified with a message prompt.  Click on OK to dismiss this message. 

Step 6. If an error log was generated use any ASCII text editor to review errors. Make 
corrections in plan view graphics as needed and reprocess. 

Step 7. If no control points are found then a message is given indicating that situation 
otherwise the final completion message is given. Click on OK to dismiss this 
message. 

Step 8. Edit the control point data in the table to show point numbers, coordinate decimals to 
4 places and elevations for benchmarks. 



Prop. R.O.W. 
Loss of Access 
D&C location: Drafting Standards> Prop. R.O.W.> Loss of Access 
Microstation Macro Program: LossOfAccessPattern.ba 
Description: 
This application sets the parameters needed to pattern a loss of access area and places the pattern
using Microstation's Pattern Area Flood by Selection Set or Pattern Area by Element. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Loss of Access or by using the keyin MACRO LOSSOFACCESSPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage: 

Step 1. Create a Microstation selection set of elements for flood mode or a shape element for 
element placement mode. 

Step 2. In D&C manager activate Loss of Access. The Pattern Area dialog appears. Defaults 
that come up are English units and Selection Set Flood mode. The active scale value 
is read from the active scale currently set in the design file. 

Step 3. Make settings as needed: 

Set Units to English or Metric. 
Set Active Scale to an alternate value if needed. If changed this will reset the active 
scale in the file. This should be set to the scale at which the pattern graphics are 
to be plotted. 
Choose the Mode desired from the two options Selection Set Flood or Shape 
Element. 

Step 4. Once settings are made click on the Apply Area Pattern button and the dialog will 
disappear.  Area pattern parameters are set in the file based on the dialog settings. 



Depending on the area pattern placement mode chosen the following prompts are given:


Selection Set Flood mode:


Step 5. The user is first prompted to Data Point in Center of Area. Enter a data point

somewhere within the area to be patterned. 

Step 6.	 The area pattern is applied and the user is then prompted to Identify Area Pattern 
for Level Move. Data point any element which is part of the pattern and all of the 
elements are moved to the appropriate level. 



 Shape Element mode: 

Step 5.	 The user is prompted to Identify Shape Element. Data point on edge of shape 
element to be patterned. 

Step 6.	 The shape element is first level moved to the appropriate pattern level and then the 
area pattern is applied. After patterning the shape element is automatically level 
moved to scratch level 30. 



ROW Flags 
D&C location: Drafting Standards> Prop. R.O.W.> ROW Flags 
Geopak 3PC Program: place_row_flags.x 
Description: 
This application reads a selection set of proposed R.O.W. lines and calculates & then places
station and offset flags at each break and if desired R.O.W. markers are placed as well. 

The prop. R.O.W. flags are placed at the alignment angle. To aide in the clean up of flag
locations the text information and it's horizontal line form a single graphic group allowing them
to be easily relocated with a single move command. The leader can then be modified to the new
location of the horizontal line. Microstation's Fence Stretch may be used to re-position flags in
some cases where flag graphics can be fenced. 

Proposed R.O.W. marker types are determined based on the 45 degree rule. Any turn out greater
than 45 degrees requires a C marker, any turn in greater than 45 degrees requires a B marker and
all others are to be type A markers. The type is labeled with the marker. No marker is placed if
there is no change in direction between R.O.W. lines. This is done to prevent placement at
R.O.W. and property line intersections. 

A ROW marker and it's text label form a single graphic group to aide in clean-up if the marker is
to be removed totally. Be sure to turn off graphic group lock prior to repositioning it's text label 
to avoid moving the marker. 

Complete documentation of all prop. R.O.W. procedures can be found in ProposedROW.pdf. 

Special Requirements: 
Proposed R.O.W. lines must be previously displayed using D&C manager and added to a
Microstation selection set. 

Selection set should contain any connected group of prop. R.O.W. lines that are referenced to a 
specified chain. 

Use of line strings or complex chains are not supported. 

Usage: 

Step 1. Display proposed R.O.W. lines using D&C manager. 

Step 2. Add a connected group of proposed R.O.W. lines to a Microstation selection set. 

Step 3. In D&C manager activate ROW Flags. 

Step 4. You are prompted for a job no. Key that in and click OK. 



Step 5. You are then prompted for the chain name. Key that in and click OK. 

Step 6. Finally you are given an option to place prop. R.O.W. markers. Click OK to place 
them or Cancel to skip placement.. 

Step 7.	 Station/Offset flags are placed at all locations along the prop. R.O.W. lines in the 
selection set. If requested prop. R.O.W. markers and their text labels are placed 
everywhere except at the beginning and end or at any location where there is no 
change in direction. Use Microstation to re-position labels as needed for clarity in the 
plans. 



ROW Marker 
D&C location: Drafting Standards> Prop. R.O.W.> ROW Marker 
Geopak 3PC Program: place_row_marker.x 
Description: 
This application reads a selection set of 2 adjoining proposed R.O.W. lines, calculates the angles
between them & then places the appropriate R.O.W. marker and labels it. 

Proposed R.O.W. marker types are determined based on the 45 degree rule. Any turn out greater
than 45 degrees requires a C marker, any turn in greater than 45 degrees requires a B marker and
all others are to be type A markers. The type is labeled with the marker. 

A ROW marker and it's text label form a single graphic group to aide in clean-up if the marker is
to be removed totally. Be sure to turn off graphic group lock prior to repositioning it's text label 
to avoid moving the marker. 

Complete documentation of all prop. R.O.W. procedures can be found in ProposedROW.pdf. 

Special Requirements: 
Two adjoining proposed R.O.W. lines must be previously displayed using D&C manager and
added to a Microstation selection set. 

Use of line strings or complex chains are not supported. 

Usage: 

Step 1.	 Display proposed R.O.W. lines using D&C manager if needed. 

Step 2.	 Create a Microstation selection set of the two adjoining R.O.W. lines. They should be 
selected in a forward direction along the main roadway. Hold Ctrl down on the 
keyboard and data point on the lines in order as shown below. 

On the first intersection of the side road prop. R.O.W. 



or on the other side 

Step 3. In D&C manager activate ROW Marker.


Step 4. You are prompted for a job no. Key that in and click OK.


Step 5. You are then prompted for the chain name. Key that in and click OK. 

Step 6. Angles between prop. R.O.W. lines are measured and the marker is placed. Use 
Microstation to re-position label as needed for clarity in the plans. 



Prop. Easements 
Slope Esmt Area 
D&C location: Drafting Standards>Prop. Easements> Slope Esmt Area 
Microstation Macro Program: SlopeEsmtPattern.ba 
Description: 
This application sets the parameters needed to pattern a prop. slope easement area and places the
pattern using Microstation's Pattern Area Flood by Selection Set or Pattern Area by 
Element. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Slope Easement or by using the keyin MACRO SLOPEESMTPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.


Drain Esmt Area 
D&C location: Drafting Standards>Prop. Easements> Drain Esmt Area 
Microstation Macro Program: DrainEsmtPattern.ba 
Description: 
This application sets the parameters needed to pattern a prop. drainage easement area and places
the pattern using Microstation's Pattern Area Flood by Selection Set or Pattern Area by 
Element. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Drainage Easement or by using the keyin MACRO DRAINESMTPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.




Const Esmt Area 
D&C location: Drafting Standards>Prop. Easements> Const Esmt Area 
Microstation Macro Program: ConstEsmtPattern.ba 
Description: 
This application sets the parameters needed to pattern a prop. construction easement area and
places the pattern using Microstation's Pattern Area Flood by Selection Set or Pattern Area 
by Element. 

This patterning is not required for construction easement for the purpose of slope construction. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Construction Easement or by using the keyin MACRO CONSTESMTPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.


Wetlands Mit A 
D&C location: Drafting Standards>Prop. Easements> Wetlands Mit A 
Microstation Macro Program: WetlandsMitArea.ba 
Description: 
This application sets the parameters needed to pattern a prop. wetlands mitigation area and
places the pattern using Microstation's Pattern Area Flood by Selection Set or Pattern Area 
by Element. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Wetlands Mitigation Area or by using the keyin MACRO 
WETLANDSMITAREA. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.




Roadway Linework 
Reinf Concrete 
D&C location: Drafting Standards>Roadway Linework> Reinf Concrete 
Microstation Macro Program: ReinforcedConcretePattern.ba 
Description: 
This application sets the parameters needed to pattern a reinforced concrete area and places the
pattern using Microstation's Pattern Area Flood by Selection Set or Pattern Area by 
Element. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Reinforced Concrete or by using the keyin MACRO 
REINFORCEDCONCRETEPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.


Scarify Pvmt 
D&C location: Drafting Standards> Roadway Linework > Scarify Pvmt 
Microstation Macro Program: ScarifyPattern.ba 
Description: 
This application sets the parameters needed to pattern an exist. pavement scarify area and places
the pattern using Microstation's Pattern Area Flood by Selection Set or Pattern Area by 
Element. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Scarify or by using the keyin MACRO SCARIFYPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.




Crown Vetch 
D&C location: Drafting Standards> Roadway Linework > Crown Vetch 
Microstation Macro Program: CrownVetchPattern.ba 
Description: 
This application sets the parameters needed to pattern a crown vetch slope area and places the
pattern using Microstation's Pattern Area Flood by Selection Set or Pattern Area by 
Element. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Crown Vetch or by using the keyin MACRO CROWNVETCHPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.




 Private Drives 
Pvt Dr Shading 
D&C location: Drafting Standards>Private Drives> Pvt Dr Shading 
Microstation Macro Program: PvtDrShading.ba 
Description: 
This application sets the parameters needed to shade in private drives and places the pattern
using Microstation's Pattern Area Flood by Selection Set or Pattern Area by Element. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Private Drive Shading or by using the keyin MACRO PVTDRSHADING. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.


HA Driveway Pts 
D&C location: Drafting Standards>Private Drives> HA Driveway Pts 
Geopak 3PC Program: draw_horiz_points_PvtDr.x 
Description: 
Uses text symbol characters to mark all points on private drive horizontal alignments. 
This is only used on more complex or critically located private drives which are developed using
roadway tools. 

Special Requirements: 
All alignment graphics must be visible in View Window #1.


Usage:

This option functions just the same as HA Points. See the description of it's usage for details.




VA Driveway Pts 
D&C location: Drafting Standards>Private Drives> VA Driveway Pts 
Geopak 3PC Program: draw_ vert _points_PvtDr.x 
Description: 
Uses text symbol characters to mark points & labels VPCs & VPTs with station & elevation on
private drive vertical alignment curves as well as the begin and end points of the vertical
alignment if they are not curve points. 

This is only used on more complex or critically located private drives which are developed using
roadway tools. 

Special Requirements: 
All alignment graphics must be visible in View #1 and a Geopak profile cell must be present.


Usage:

This option functions just the same as VA Points. See the description of it's usage for details.




Exist. Drainage 
HA Stream Pts 
D&C location: Drafting Standards> Exist. Drainage > HA Stream Pts 
Geopak 3PC Program: draw_horiz_points_ Stream.x 
Description: 
Uses text symbol characters to mark all points on exist. stream horizontal alignments. 

Special Requirements: 
All alignment graphics must be visible in View Window #1.


Usage:

This option functions just the same as HA Points. See the description of it's usage for details.




Prop. Drainage 
Plan Box 
D&C location: Drafting Standards>Prop. Drainage> Structures in Plan>Plan Box 
Microstation Macro Program: drawboxplan.ba 
Description: 
This application is used to draw a proposed box culvert or bridge in the plan view. 

Supports English or Metric application. 

Special Requirements: 
The centerline of the structure must be established prior to running the application. 

Usage: 

Step 1.	 Establish the centerline of the structure. This may have been done during the design 
process using Geopak Drainage or with Microstation tools but here we will illustrate 
the use of Geopak's Draw Pattern tool to get this done. From Project Manager or the 
Geopak tool box activate the Draw Pattern tool. 

Set the job number and chain name for the roadway. 

Change the placement control at the bottom for placement Once and change 
symbology settings as desired. 

Only the Beginning side of the dialog should be active now and there you now can set 
the Offset LT, Station & Offset RT. 

If the structure is at 90 degrees (0 degrees on dialog) you can go ahead and hit Apply 
to draw the structure. If the structure is skewed click on the Skew option. 

Skew values in this dialog are measured from a normal 90 degree line not the 
centerline as we normally consider them. So to get the skew value to enter in the 
dialog. subtract  the skew from 90. Skews to the left should be entered as positive and 
skews to the right as negative. (Example: 60 degree skew left  90-60=30) 

In this example our box bridge is 45 degrees right so we enter a -45 for the skew 
value. Hit Apply to draw the structure centerline. 



Step 2.	 In D&C manager activate Plan Box. The Draw Box Culvert or Bridge in Plan by 2 
Points dialog opens. Defaults which are displayed . . . Number of Barrels 1, Skew 
Angle 90, Skew Direction None & Label Scale (Current Active Scale). Note that 
skew angles in degrees minutes & seconds are supported and wing walls are optional. 

Step 3.	 Make settings in the dialog as needed for the structure you need to draw. In our 
example we are placing a 3 @ 10X8 structure at a 45 degree skew right. From 
standard structure drawing STD-15-111 we get the short wingwall (WS) length of 9' 
and a long wingwall (WL) length of 20.25'.  Once settings are made click on the 
Draw Structure button. 



Step 4. You are then prompted to Identify Left End of Structure. Snap and Data point at 
that end of the structure centerline. 

Step 5. You are then prompted to Identify Right End of Structure. Snap and Data point at 
that end of the structure centerline. 



Step 6. The structure is drawn and the user is prompted to Identify location for label. A 
Reset can be given to skip placement or Data point at location for label to be placed. 

Step 7. Finally if the label was placed you are prompted to Identify location for leader line. 
Data point at structure where you wish the leader line to end. 



Step 8. The structure with label is now complete. Note that centerline length of structure is 
checked to determine whether label should specify bridge or culvert. 



A Endwall 
D&C location: Drafting Standards>Prop. Drainage> Structures in Plan>A Endwall 
Microstation Macro Program: drawAEWplan.ba 
Description: 
This application used draw a proposed type A endwall on a pipe end in the plan view. All control
values in dialog are based on data in standard roadway drawing D-PE-1. 
Endwall information used for placement and associated quantities are added to CSV file
EndwallTabulation.csv. 
Supports English or Metric application. 

Special Requirements: 
The proposed pipe must be drawn in the plan view. 

Usage: 

Step 1.	 Draw the proposed pipe in the plan view. This may have been done during the design 
process using Geopak Drainage, with Microstation tools or by using Geopak's  Draw 
Pattern tool with D&C Manager's Place Influence on to set the appropriate 
symbology for the desired pipe size. See Step 1 of the Plan Box program description 
above for an explanation of using the Draw Pattern tool for this. 

Step 2.	 In D&C manager activate A Endwall. The Draw Prop. Type "A" Pipe Endwall  in 
Plan dialog opens. Defaults which are displayed . . . Pipe Size 36", Pipe Type Cross 
Drain, Skew Angle 90 & Skew Direction None. Also note that skew angles in 
degrees minutes & seconds are supported. 

Step 3.	 Make settings in the dialog as needed for the pipe endwall you need to draw. In our 
example we are placing an endwall on a 48" pipe cross drain at a 60 degree skew left. 
The Pipe Type setting controls the level for placement. Once settings are made click 
on the Draw Structure button. 



Step 4. You are then prompted to Identify Point at Endwall. Snap and Data point at the 
end of the pipe where endwall should be drawn. 

Step 5. You are then prompted to Identify other end of pipe. Snap and Data point at the 
other end of the pipe. 



Step 6.	 The endwall is drawn and the dialog re-appears.  You can click on Draw Structure 
to place another endwall of the same type at the other end or click on Cancel to exit 
the program. 

Step 7.	 When endwalls are placed in graphics, information used for placement and associated 
quantities are added to CSV file EndwallTabulation.csv in your project directory. 
Data from this file can later be imported into Excel and used to tabulate final 
quantites for endwalls. 



U Endwall 
D&C location: Drafting Standards>Prop. Drainage> Structures in Plan>U Endwall 
Microstation Macro Program: drawUEWplan.ba 
Description: 
This application used draw a proposed type U endwall on a pipe end in the plan view. Endwall
can be placed with safety grate if required. All control values in dialog are based on data in
standard roadway drawings D-PE-3B, D-PE-4, D-PE-4B & D-PE-6B. 
Endwall information used for placement and associated quantities are added to CSV file
EndwallTabulation.csv. 
Supports English or Metric application. 

Special Requirements: 
The proposed pipe must be drawn in the plan view. 

Usage: 

Step 1.	 Draw the proposed pipe in the plan view. This may have been done during the design 
process using Geopak Drainage, with Microstation tools or by using Geopak's  Draw 
Pattern tool with D&C Manager's Place Influence on to set the appropriate 
symbology for the desired pipe size. See Step 1 of the Plan Box program description 
above for an explanation of using the Draw Pattern tool for this. 

Step 2.	 In D&C manager activate U Endwall. The Draw Prop. Type "U" Pipe Endwall  in 
Plan dialog opens. Defaults which are displayed . . . Pipe Size 18", Pipe Type Cross 
Drain, Number of Pipes 1, Side Slope 6:1 & Endwall Type w/grate.  Note that 
multiple pipes and 2:1 or 1.5:1 slopes are only allowed with pipe sizes 18"-30" and if 
a grate is specified but not required the endwall is drawn without the grate. 

Step 3. Make settings in the dialog as needed for the pipe endwall you need to draw. The 
Pipe Type setting controls the level for placement. Once settings are made click on 
the Draw Structure button. 

Step 4. You are then prompted to Identify Point at Endwall. Snap and Data point at the 
end of the pipe where endwall should be drawn. 

Step 5. You are then prompted to Identify other end of pipe. Snap and Data point at the 
other end of the pipe. 



Step 6.	 The endwall is drawn and the dialog re-appears.  You can click on Draw Structure 
to place another endwall of the same type at the other end or click on Cancel to exit 
the program. 

Step 7.	 When endwalls are placed in graphics, information used for placement and associated 
quantities are added to CSV file EndwallTabulation.csv in your project directory. 
Data from this file can later be imported into Excel and used to tabulate final 
quantities for endwalls. 



SD Endwall 
D&C location: Drafting Standards>Prop. Drainage> Structures in Plan>SD Endwall 
Microstation Macro Program: drawSDEWplan.ba 
Description: 
This application used draw a proposed type SD endwall on a pipe end in the plan view. All
control values in dialog are based on data in standard roadway drawings D-SEW-6DA & D
SEW-12D. 
Endwall information used for placement and associated quantities are added to CSV file
EndwallTabulation.csv. 
Supports English or Metric application. 

Special Requirements: 
The proposed pipe must be drawn in the plan view. 

Usage: 

Step 1.	 Draw the proposed pipe in the plan view. This may have been done during the design 
process using Geopak Drainage, with Microstation tools or by using Geopak's  Draw 
Pattern tool with D&C Manager's Place Influence on to set the appropriate 
symbology for the desired pipe size. See Step 1 of the Plan Box program description 
above for an explanation of using the Draw Pattern tool for this. 

Step 2.	 In D&C manager activate SD Endwall. The Draw Prop. Type "SD" Pipe Endwall 
in Plan dialog opens. Defaults which are displayed . . . Pipe Size 15" & Side Slope 
6:1.  Note that 12:1 side slopes are only allowed with pipe sizes 15"-18". 

Step 3. Make settings in the dialog as needed for the pipe endwall you need to draw. Once 
settings are made click on the Draw Structure button. 

Step 4. You are then prompted to Identify Point at Endwall. Snap and Data point at the 
end of the pipe where endwall should be drawn. 

Step 5. You are then prompted to Identify other end of pipe. Snap and Data point at the 
other end of the pipe. 



Step 6.	 The endwall is drawn and the dialog re-appears.  You can click on Draw Structure 
to place another endwall of the same type at the other end or click on Cancel to exit 
the program. 

Step 7.	 When endwalls are placed in graphics, information used for placement and associated 
quantities are added to CSV file EndwallTabulation.csv in your project directory. 
Data from this file can later be imported into Excel and used to tabulate final 
quantities for endwalls. 



ST Endwall 
D&C location: Drafting Standards>Prop. Drainage> Structures in Plan>ST Endwall 
Microstation Macro Program: drawSTEWplan.ba 
Description: 
This application used draw a proposed type ST/straight endwall on a pipe end in the plan view.
All control values in dialog are based on data in standard roadway drawing D-PE-4. 
Endwall information used for placement and associated quantities are added to CSV file
EndwallTabulation.csv. 
Supports English or Metric application. 

Special Requirements: 
The proposed pipe must be drawn in the plan view. 

Usage: 

Step 1.	 Draw the proposed pipe in the plan view. This may have been done during the design 
process using Geopak Drainage, with Microstation tools or by using Geopak's  Draw 
Pattern tool with D&C Manager's Place Influence on to set the appropriate 
symbology for the desired pipe size. See Step 1 of the Plan Box program description 
above for an explanation of using the Draw Pattern tool for this. 

Step 2.	 In D&C manager activate ST Endwall. The Draw Prop. Type Straight Pipe 
Endwall  in Plan dialog opens. Defaults which are displayed . . . Pipe Size 18", Pipe 
Type Cross Drain, Number of Pipes 1, Skew Angle 90 & Skew Direction None. 
Note that skew angles in degrees minutes & seconds are supported.. 

Step 3. Make settings in the dialog as needed for the pipe endwall you need to draw. The 
Pipe Type setting controls the level for placement. Once settings are made click on 
the Draw Structure button. 

Step 4. You are then prompted to Identify Point at Endwall. Snap and Data point at the 
end of the pipe where endwall should be drawn. 

Step 5. You are then prompted to Identify other end of pipe. Snap and Data point at the 
other end of the pipe. 



Step 6.	 The endwall is drawn and the dialog re-appears.  You can click on Draw Structure 
to place another endwall of the same type at the other end or click on Cancel to exit 
the program. 

Step 7.	 When endwalls are placed in graphics, information used for placement and associated 
quantities are added to CSV file EndwallTabulation.csv in your project directory. 
Data from this file can later be imported into Excel and used to tabulate final 
quantities for endwalls. 



L Endwall 
D&C location: Drafting Standards>Prop. Drainage> Structures in Plan>L Endwall 
Microstation Macro Program: drawLEWplan.ba 
Description: 
This application used draw a proposed type L endwall on a pipe end in the plan view. All control
values in dialog are based on data in standard roadway drawing D-PE-4. 
Endwall information used for placement and associated quantities are added to CSV file
EndwallTabulation.csv. 
Supports English or Metric application. 

Special Requirements: 
The proposed pipe must be drawn in the plan view. 

Usage: 

Step 1.	 Draw the proposed pipe in the plan view. This may have been done during the design 
process using Geopak Drainage, with Microstation tools or by using Geopak's  Draw 
Pattern tool with D&C Manager's Place Influence on to set the appropriate 
symbology for the desired pipe size. See Step 1 of the Plan Box program description 
above for an explanation of using the Draw Pattern tool for this. 

Step 2.	 In D&C manager activate L Endwall. The Draw Prop. Type L Pipe Endwall  in 
Plan dialog opens. Defaults which are displayed . . . Pipe Size 18", Pipe Type Cross 
Drain, Number of Pipes 1, Side for Wingwall Left, Skew Angle 90 & Skew 
Direction None. Note that skew angles in degrees minutes & seconds are supported.. 

Step 3. Make settings in the dialog as needed for the pipe endwall you need to draw. The 
Pipe Type setting controls the level for placement.  Side for wingwall is as seen 
looking out away from roadway. Once settings are made click on the Draw 
Structure button. 

Step 4. You are then prompted to Identify Point at Endwall. Snap and Data point at the 
end of the pipe where endwall should be drawn. 

Step 5. You are then prompted to Identify other end of pipe. Snap and Data point at the 
other end of the pipe. 



Step 6.	 The endwall is drawn and the dialog re-appears.  You can click on Draw Structure 
to place another endwall of the same type at the other end or click on Cancel to exit 
the program. 

Step 7.	 When endwalls are placed in graphics, information used for placement and associated 
quantities are added to CSV file EndwallTabulation.csv in your project directory. 
Data from this file can later be imported into Excel and used to tabulate final 
quantities for endwalls. 



Profile Box 
D&C location: Drafting Standards>Prop. Drainage> Structures on Profiles>Profile Box 
Microstation Macro Program: drawboxprofile.ba 
Description: 
This application is used to draw a proposed box culvert or bridge on a profile. 

Supports English or Metric application. 

Special Requirements: 
The center flow line point of the structure must be located in graphics prior to running the
application. 

Usage: 

Step 1.	 Establish the center flow line point of the structure. This may be located with 
Microstation tools or with Geopak's Vertical Alignment Generator and it's Issue 
Data Point tool. 

Step 2.	 In D&C manager activate Profile Box. The Draw Box Culvert or Bridge on Profile 
by Flow Point dialog opens. Defaults which are displayed . . . Number of Barrels 1, 
Outside Wall 8 inches, Inside Wall 8 inches, Top Slab 12 inches, Bottom slab 12 
inches, Skew Angle 90, Label Scale (Current Active Scale) & Vertical 
Exaggeration 10. Note that skew angles in degrees minutes & seconds are supported. 

Vertical Exaggeration should usually be 10 for profiles …

(Example: 50 scale horiz. / 5 scale vert. = 10)

It is provided for special profile cases and for the occasional need to draw on culvert

sections which would use an exaggeration value of 1.




Step 3.	 Make settings in the dialog as needed for the structure you need to draw. In our 
example we are placing a 3 @ 10X8 structure with a 3' fill height at a 90 degree 
skew. From standard structure drawing STD-15-79 we get the outside wall (WT) 
thickness of 8" and an inside wall (IT) thickness of 8" so we can use the defaults. The 
top slab (ST) thickness is 9" and the bottom slab (SB) thickness is 8" so we enter 
those.  Once settings are made click on the Draw Structure button. 

Step 4. You are then prompted to Identify Flow Line Location at Center. Snap and Data 
point at the flow line point. 



Step 6.	 The structure is drawn and the user is prompted to Identify location for Drainage 
Data. A Reset can be given to skip placement or Data point at location for the data 
cell to be placed. 

Step 8.	 The data cell is placed and size, type & skew data is added. Note that centerline 
length of structure is checked to determine whether text should specify bridge or 
culvert. 



Profile Slab 
D&C location: Drafting Standards>Prop. Drainage> Structures on Profiles>Profile Slab 
Microstation Macro Program: drawslabprofile.ba 
Description: 
This application is used to draw a proposed slab culvert or bridge on a profile. 

Supports English or Metric application. 

Special Requirements: 
The center flow line point of the structure must be located in graphics prior to running the
application. 

Usage: 

Step 1.	 Establish the center flow line point of the structure. This may be located with 
Microstation tools or with Geopak's Vertical Alignment Generator and it's Issue 
Data Point tool. 

Step 2.	 In D&C manager activate Profile Slab. The Draw Slab Culvert or Bridge on 
Profile by Flow Point dialog opens. Defaults which are displayed . . . Number of 
Barrels 1, Outside Wall 8 inches, Inside Wall 8 inches, Top Slab 12 inches, 
Footing slab 18 inches, Skew Angle 90, Label Scale (Current Active Scale) & 
Vertical Exaggeration 10. Note that skew angles in degrees minutes & seconds are 
supported. 

Vertical Exaggeration should usually be 10 for profiles …

(Example: 50 scale horiz. / 5 scale vert. = 10)

It is provided for special profile cases and for the occasional need to draw on culvert

sections which would use an exaggeration value of 1.


Footing Slab thickness should be 18" for most standard slab culvert and bridge

structures but is provided for special cases where it may not be.




Step 3.	 Make settings in the dialog as needed for the structure you need to draw. In our 
example we are placing a 2 @ 14X7 structure with a 6' fill height at a 45 degree 
skew. From standard structure drawing STD-15-122 we get the outside wall (WT) 
thickness of 8", an inside wall (IT) thickness of 8" and a footing slab thickness of 18" 
so we can use the defaults. The top slab (ST) thickness is 11" so we enter that.  Once 
settings are made click on the Draw Structure button. 

Step 4. You are then prompted to Identify Flow Line Location at Center. Snap and Data 
point at the flow line point. 



Step 6.	 The structure is drawn and the user is prompted to Identify location for Drainage 
Data. A Reset can be given to skip placement or Data point at location for the data 
cell to be placed. Due to the 45 degree skew, structure widths are adjusted. 

Step 8.	 The data cell is placed and size, type & skew data is added. Note that centerline 
length of structure is checked to determine whether text should specify bridge or 
culvert. 



Profile Pipe 
D&C location: Drafting Standards>Prop. Drainage> Structures on Profiles>Profile Pipe 
Microstation Macro Program: drawpipeprofile.ba 
Description: 
This application is used to draw a proposed pipe(s) on a profile. 

Supports English or Metric application. 

Special Requirements: 
The center flow line point of the pipe(s) must be located in graphics prior to running the
application. 
Usage: 
Step 1.	 Establish the center flow line point of the pipe(s). This may be located with 

Microstation tools or with Geopak's Vertical Alignment Generator and it's Issue 
Data Point tool. 

Step 2.	 In D&C manager activate Profile Pipe. The Draw Prop. Pipe(s) on Profile by 
Center Flow Point dialog opens. Defaults which are displayed . .Number of Pipes 1, 
Space between Pipes 12 inches, Skew Angle 90, Vertical Exaggeration 10, Label 
Control - Scale (Current Active Scale) & Label Control - Type Cross Drain. Note 
that skew angles in degrees minutes & seconds are supported. 

Pipe Size - Width is optional and is provided so that horizontal & vertical oval pipes

can be drawn as needed.

Vertical Exaggeration should usually be 10 for profiles …

(Example: 50 scale horiz. / 5 scale vert. = 10)

It is provided for special profile cases and for the occasional need to draw on culvert

sections which would use an exaggeration value of 1.

Label Control - Type controls the format of labeling provided.

Cross Drain - Profile Drainage Data Cell

Storm Sewer - EW storm sewer drainage code cell with leader line

Side Drain - Text label: __' OF pipe size" S.D. REQD.




Step 3.	 Make settings in the dialog as needed for the pipe(s) you need to draw. In our 
example we are placing a 48" cross drain at a 90 degree skew. Once settings are made 
click on the Draw Structure button. 

Step 4. You are then prompted to Identify Flow Line Location at Center. Snap and Data 
point at the flow line point. 



Step 6.	 The pipe is drawn and the user is prompted to Identify location for Drainage Data. 
A Reset can be given to skip placement or Data point at location for the data cell to 
be placed. 

Since it is difficult to see small pipes on profiles when drawn at actual size, this 
program plots pipes at a minimum width of  42"(3.5') when the Vertical 
Exaggeration is greater than 1. The pipe height is always shown at actual size times 
the Vertical Exaggeration value. 



Step 8. The data cell is placed and size, type & skew data is added. 

Storm Sewer label example: 

Side Drain label example: 



HA Ditch Pts 
D&C location: Drafting Standards>Prop. Drainage>Special Ditches> HA Ditch Pts 
Geopak 3PC Program: draw_horiz_points_ Ditches.x 
Description: 
Uses text symbol characters to mark all points on special ditch horizontal alignments. 

Special Requirements: 
All alignment graphics must be visible in View Window #1. 

Usage:

This option functions just the same as HA Points. See the description of it's usage for details.


VA Ditch Pts 
D&C location: Drafting Standards>Prop. Drainage> Special Ditches> VA Ditch Pts 
Geopak 3PC Program: draw_ vert _points_ Ditches.x 
Description: 
Uses text symbol characters to mark points & labels VPCs & VPTs with station & elevation on
special ditch vertical alignment curves as well as the begin and end points of the vertical
alignment if they are not curve points. 

Special Requirements: 
All alignment graphics must be visible in View #1 and a Geopak profile cell must be present.


Usage:

This option functions just the same as VA Points. See the description of it's usage for details.




Rip-Rap Area 
D&C location: Drafting Standards>Prop. Drainage> Rip-Rap Area 
Microstation Macro Program: RipRapPattern.ba 
Description: 
This application sets the parameters needed to pattern a rip-rap area and places the pattern using
Microstation's Pattern Area Flood by Selection Set or Pattern Area by Element. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Rip Rap or by using the keyin MACRO RIPRAPPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.




Flow Direction 
D&C location: Drafting Standards>Prop. Drainage> Flow Direction 
Microstation Macro Program: drawflowdirection.ba 
Description: 
This application used draw a flow direction arrowhead with leader line. 

Special Requirements: 
None 

Usage: 

Step 1.	 In D&C manager activate Flow Direction. The Draw Flow Direction by 2 Points 
dialog opens. The only entry field is Cell Scale which reflects the current active scale. 
Reset this value if needed and click on the Draw Flow button. 

Step 2. You are then prompted to Identify Point for Arrowhead. Data point at the location 
for the arrowhead. 



Step 3. You are then prompted to Identify End of Leader Line. Data point at the location 
for the other end of the leader line. 

Step 4.	 The leader line is completed and the arrowhead is added. You can continue to place 
additional flow direction indicators if desired. These graphics are a graphic group so 
they can easil;y be moved if needed. This application is intended for showing the 
flow direction on a creek of river but could be used to develop flow patterns for a 
drainage map although Geopak's DTM Tools will do this automatically. 



 Guardrail 
Vehicle Path 
D&C location: Drafting Standards> Guardrail> Vehicle Path 
Microstation Macro Program: traject.ba 
Description: 
This application used draw a vehicle trajectory path to help determine the point of need for
guardrail. 

The vehicle path is placed at a user defined angle from the edge of the traveled way in tangent
sections and in curves a tangent is generated from the curve element. 

Special Requirements: 
The edge of traveled way linework (prop. edge of pavement and/or centerline) and hazard
location must be drawn in the file. 

When placement is near the end of tangent sections then the path should be checked since it may
start beyond the end of the tangent. 

When the path falls within a spiral or curve then good engineering judgement should be used to
ensure adequate protection from the hazard. 

In spirals you may wish to use a path located by divergent angle based on the tangent near the
beginning of the spiral and a tangent line from the spiral as it nears the curve. Since Geopak uses
curve strings to plot in spirals then only tangent paths can be placed from spirals using this 
program. 

Usage: 

Step 1.	 Locate hazard locations and display centerline and edge of proposed pavements. 

Step 2.	 In D&C manager activate Vehicle Path. The Draw Vehicle Trajectory Path dialog 
opens. It contains the following settings to control the program's function: 

Alignment Orientation : Tangent Section or Curve Section 
For tangent sections a line is drawn at the given angle from the edge of the 
traveled way to the hazard.  For curve sections a line tangent to the curve is drawn 
from the edge of the traveled way to the hazard. 

Path to Hazard Location: Begin or End & Left or Right. 
This is the general location of where the path originates in relation to the hazard 
going forward along the centerline. 

Tangent Trajectory Angle: numeric value. 
This is the angle which will be used to draw trajectory paths from tangents. 

Default value of 15 degrees is given. 



Make settings as needed and click on the Draw Trajectory Line button. 

Step 3.	 You are then prompted to Identify edge of travel way. Data point on the edge of 
pavement or centerline. In this example we are working with a 2 lane roadway in a 
tangent section at the beginning of a bridge on the left so we data point on the 
centerline for that location. 



Step 4.	 The trajectory line appears floating along the centerline and you are then prompted to 
Identify Hazard Location. I our example the first hazard is a 2:1 slope prior to the 
bridge so we snap to that slope tie and Data point. The path line is drawn and the 
Draw Vehicle Trajectory Path dialog re-appears. 

Step 5. You can click Cancel to quit or make new settings and click Draw Trajectory Line 
to place another trajectory line. In our example we reset it to Begin Right to continue. 



Step 6. Repeating steps 3 & 4 this time we identify the right edge of pavement and data point 
at the beginning of 2:1 slopes on the right side. 

Step 7.	 In our example the roadway approach at the end of the bridge is in a curve so we reset 
the Alignment Orientation to a Curve Section, the  Path to Hazard Location to End 
Left and click Draw Trajectory Line to continue. 



Step 8.	 Repeating steps 3 & 4 this time we identify the left edge of pavement past the bridge 
in the curve and data point at the end of 2:1 slopes on the left side. A curve tangent 
path line is drawn.  After  resetting to End Left we attempt to place a tangent from 
the centerline to the end of 2:1 slopes on the right. 

Since a tangent cannot be placed on the inside of a curve the following error message is 
displayed. Good engineering judgement will have to be used in areas such as this one. 

WARNING:

Anytime the trajectory path begins within a spiral or curve then good engineering

judgement should always be used to ensure adequate protection from the hazard.




GR Br End Prop.

D&C location: Drafting Standards> Guardrail> GR Br End Prop.

Geopak 3PC Program: place_Br_end_GR.x


Description:

This application plots the standard length of bridge end guardrail (26' 10 3/4") with the 
appropriate custom linestyle. 

This 3PC is used to plot the bridge end guardrail  separately when minimum installations of
guardrail at bridge ends which already include this guardrail section do not provide adequate
protection. 

Locations for guardrail are plotted by station and offset to directly reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects. 

Special Requirements: 
Bridge end location for beginning of guardrail must be located graphically so that it  can be 
identified when using program. 

Usage: 

Step 1. Locate bridge end location for beginning of guardrail. 

Step 2. In D&C manager activate GR Br End Prop. 

Step 3. You are prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 



Step 5. You are then prompted for the guardrail location in relation to the bridge end, Begin 
or End and Left or Right (going in the direction of the centerline). Pick the 
appropriate option from the list box and click OK. 

Step 6. You are then prompted to Snap & Data end of the bridge Rail where the guardrail 
begins. Snap and Data Point at that location. 

The standard length of bridge end guardrail (26' 10 3/4") is drawn in using the 
appropriate custom linestyle. 



GR Term 12_2:1 
D&C location: Drafting Standards> Guardrail> GR Term 12_2:1 
Geopak 3PC Program: place_12_2to1_terminal.x 
Description: 
This application plots a type 12 guardrail terminal, the 13:1 taper and curve to tie to the guardrail
at the roadside. A type text label is placed for the terminal as well as a point at the terminal
location for later use in calculating quantities. The special slope limit lines used by cross section
criteria to show pads and alter side slopes are also plotted on level 30. 

This 3PC is for use when cut backslopes are at a 2:1 slope. 

Locations for guardrail and special slope limit lines are plotted by station and offset to directly
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects. 

Special Requirements: 
Point of need at ditch line and guardrail offset location at roadside must be located graphically so
that they can be identified when using program. 

Usage: 

Step 1. Locate point of need at ditch line and guardrail offset location at roadside. 

Step 2. In D&C manager activate GR Term 12_2:1. 

Step 3. You are prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 



Step 5.	 You are then prompted for the terminal location in the guardrail run, Begin or End 
and Left or Right (going in the direction of the centerline). Pick the appropriate 
option from the list box and click OK. 

Step 6. You are then prompted for the Point of Need at Ditch. Snap to that location and 
Data Point. 

Step 7.	 Finally you are prompted to Data on guardrail at roadside. Snap and Data Point 
on the guardrail anywhere along the roadway. This does not have to be at any critical 
location in the guardrail line. The location where the 13:1 taper starts will be 
calculated and located by the program. 



Step 8.	 All line work is plotted in the file based on the given information. Use Microstation's 
modify commands to adjust the guardrail run along the roadway to end where curve 
into 13:1 taper begins. 

Special slope limit lines are placed on level 30. It may be necessary to turn that level on 
to see them after processing. 



GR Term 12_4:1 
D&C location: Drafting Standards> Guardrail> GR Term 12_4:1 
Geopak 3PC Program: place_12_4to1_terminal.x 
Description: 
This application plots a type 12 guardrail terminal, the 13:1 taper and curve to tie to the guardrail
at the roadside. A type text label is placed for the terminal as well as a point at the terminal
location for later use in calculating quantities. The special slope limit lines used by cross section
criteria to show pads and alter side slopes are also plotted on level 30. 

This 3PC is for use when cut backslopes are at a 4:1 slope. 

Locations for guardrail and special slope limit lines are plotted by station and offset to directly
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects. 

Special Requirements: 
Point of need at ditch line and guardrail offset location at roadside must be located graphically so
that they can be identified when using program. 

Usage: 
This option functions just the same as GR Term 12_2:1. See the description of it's usage for 
details. 



GR Term Type 13 
D&C location: Drafting Standards> Guardrail> GR Term Type 13 
Geopak 3PC Program: place_13_terminal.x 
Description: 
This application places a type 13 guardrail terminal cell,  a type text label and a point at the 
terminal location for later use in calculating quantities. 

Special Requirements: 
Terminal location at guardrail along roadside must be located graphically so that it  can be 
identified when using program. 

Usage: 

Step 1.	 Locate terminal location at guardrail along roadside. For the type 13 terminal this is 
6.25' past the end of hazard location (except for median bridge pier protection 
which requires a minimum distance of 12.5' past the pier). 

Step 2.	 In D&C manager activate GR Term Type 13. 

Step 3.	 You are prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

Step 5.	 You are then prompted for the terminal location in the guardrail run, Begin or End 
and Left or Right (going in the direction of the centerline). Pick the appropriate 
option from the list box and click OK. 



Step 6. Finally you are prompted to Snap & Data terminal location. Snap and Data Point 
on the guardrail at the terminal location. 

All graphics are placed in the file based on the given information. 



 GR Term Type 21 
D&C location: Drafting Standards> Guardrail> GR Term Type 21 
Geopak 3PC Program: place_21_terminal.x 
Description: 
This application plots a type 21 guardrail terminal with the appropriate custom linestyle and
terminal end cap. A type text label is placed for the terminal. The special slope limit lines used
by cross section criteria to show pads and alter side slopes are also plotted on level 30. 

Locations for guardrail and special slope limit lines are plotted by station and offset to directly
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects. 

Special Requirements: 
Terminal beginning location at guardrail along roadside must be located graphically so that it
can be identified when using program. 

Usage: 

Step 1. Locate beginning of terminal location at guardrail along roadside. For the type 21 
terminal this is 12.5' back from the point of need location. 

Step 2. In D&C manager activate GR Term Type 21. 

Step 3. You are prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

Step 5.	 You are then prompted for the terminal location in the guardrail run, Begin or End 
and Left or Right (going in the direction of the centerline). Pick the appropriate 
option from the list box and click OK. 



Step 6. Finally you are prompted to Snap & Data terminal location. Snap and Data Point 
on the guardrail at the terminal location. 

All line work is plotted in the file based on the given information. 

Special slope limit lines are placed on level 30. It may be necessary to turn that level on 
to see them after processing. 



GR Min Inst 21 
D&C location: Drafting Standards> Guardrail> GR Min Inst 21 
Geopak 3PC Program: place_21_min_install.x 
Description: 
This application plots a type 21 guardrail terminal, regular guardrail and bridge end guardrail
with the appropriate custom linestyles and terminal end cap for a minimum installation at a
bridge end. A type text label is placed for the terminal. The special slope limit lines used by cross
section criteria to show pads and alter side slopes are also plotted on level 30. 

Locations for guardrail and special slope limit lines are plotted by station and offset to directly
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects. 

Special Requirements: 
Bridge end location for beginning of guardrail must be located graphically so that it  can be 
identified when using program. 

Usage: 

Step 1. Locate bridge end location for beginning of guardrail. 

Step 2. In D&C manager activate GR Min Inst 21. 

Step 3. You are prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

Step 5.	 You are then prompted for the guardrail location at bridge end, Begin or End and 
Left or Right (going in the direction of the centerline). Pick the appropriate option 
from the list box and click OK. 



Step 6. Finally you are prompted to Snap & Data GR begin location. Snap and Data Point 
on the bridge end where guardrail begins. 

All line work is plotted in the file based on the given information. 

Special slope limit lines are placed on level 30. It may be necessary to turn that level on 
to see them after processing. 



GR Term Type 38 
D&C location: Drafting Standards> Guardrail> GR Term Type 38 
Geopak 3PC Program: place_38_terminal.x 
Description: 
This application plots a type 38 guardrail terminal with the appropriate custom linestyle and
terminal end cap. A type text label is placed for the terminal. The special slope limit lines used
by cross section criteria to show pads and alter side slopes are also plotted on level 30. 

Locations for guardrail and special slope limit lines are plotted by station and offset to directly
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects. 

Special Requirements: 
Terminal beginning location at guardrail along roadside must be located graphically so that it
can be identified when using program. 

Usage: 

Step 1. Locate beginning of terminal location at guardrail along roadside. For the type 38 
terminal this is 37.5' back from the point of need location. 

Step 2. In D&C manager activate GR Term Type 38. 

Step 3. You are prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

Step 5.	 You are then prompted for the terminal location in the guardrail run, Begin or End 
and Left or Right (going in the direction of the centerline). Pick the appropriate 
option from the list box and click OK. 



Step 6. Finally you are prompted to Snap & Data terminal location. Snap and Data Point 
on the guardrail at the terminal location. 

All line work is plotted in the file based on the given information. 

Special slope limit lines are placed on level 30. It may be necessary to turn that level on 
to see them after processing. 



GR Min Inst 38 
D&C location: Drafting Standards> Guardrail> GR Min Inst 38 
Geopak 3PC Program: place_38_min_install.x 
Description: 
This application plots a type 38 guardrail terminal and bridge end guardrail with the appropriate
custom linestyles and terminal end cap for a minimum installation at a bridge end. A type text
label is placed for the terminal. The special slope limit lines used by cross section criteria to
show pads and alter side slopes are also plotted on level 30. 

Locations for guardrail and special slope limit lines are plotted by station and offset to directly
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects. 

Special Requirements: 
Bridge end location for beginning of guardrail must be located graphically so that it  can be 
identified when using program. 

Usage: 
This option functions just the same as GR Min Inst 21. See the description of it's usage for 
details. 



GR Term In-Line 
D&C location: Drafting Standards> Guardrail> GR Term In-Line 
Geopak 3PC Program: place_InLine_terminal.x 
Description: 
This application places a type in-line guardrail terminal cell,  a type text label and a point at the 
terminal location for later use in calculating quantities. 

Special Requirements: 
Guardrail radius location for this terminal must be located graphically so that it  can be identified 
when using program. 

Usage: 

Step 1. Draw guardrail radius along roadway pavement radius. 

Step 2. In D&C manager activate GR Term In-Line. 

Step 3. You are prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 

Step 5. Finally you are prompted to Snap & Data terminal location. Snap and Data Point 
at the end of the radius of guardrail for the terminal location. 



Step 6. All graphics are placed in the file based on the given information. Move text label as 
needed for clarity and if needed add a leader line. 



GR Min Inst Med 
D&C location: Drafting Standards> Guardrail> Median GR> GR Min Inst Med 
Geopak 3PC Program: place_median_min_br_end.x 
Description: 
This application plots in the minimum length of guardrail required in the median at tangent non-
skewed bridges with the appropriate custom linestyle and terminal end cap. A type text label is
placed for the terminal. The special slope limit lines used by cross section criteria to alter median
slopes are also plotted on level 30. 

Locations for guardrail and special slope limit lines are plotted by station and offset to directly
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects. 

Special Requirements: 
Bridge end location for beginning of guardrail must be located graphically so that it  can be 
identified when using program. 

Usage: 

Step 1. Locate bridge end location for beginning of guardrail. 

Step 2. In D&C manager activate GR Min Inst Med. 

Step 3. You are prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 



Step 5.	 You are then prompted for the median width (30'. 36', 48', 60' or 64'). This refers to 
distance between the inside edges of the proposed travel lanes. Pick the appropriate 
width from the list box and click OK. 

Step 6.	 You are then prompted for the guardrail location on the bridge end, Begin (on right 
bridge) or End (on left bridge). Pick the appropriate option from the list box and click 
OK. 

Step 7. Finally you are prompted to Snap & Data end of Bridge Rail. Snap and Data Point 
on the end of the bridge where guardrail begins. 

All line work is plotted in the file based on the given information. 



After completion of graphics the following warning message is given reminding the 
user that this guardrail layout is based on a tangent roadway with 2 non-skewed 
bridges. If either of these are not true for this installation or your design speed is 
greater than 60 miles per hour then the guardrail  should be checked for 
adequate coverage of the hazard. 

Note that in cases where this standard length of rail does not provide adequate coverage 
then additional rail can be added and then D&C manager item GR Med Br Ends can be 
used to plot in the guardrail from the 50' curve through the terminal. 



GR Med Br Ends 
D&C location: Drafting Standards> Guardrail> Median GR> GR Med Br Ends 
Geopak 3PC Program: place_median_br_end_prot.x 
Description: 
This application places guardrail from the beginning of the 50' curve through the taper to the
terminal in the median at bridge ends. It is intended for use in areas where the minimum
installation is not adequate due to design speed, curvature or skewed bridges. After setting up the
bridge end rail and the extra regular rail for additional protection then this program can be
utilized to plot in the remaining guardrail with terminal using the appropriate custom linestyle
and terminal end cap. A type text label is placed for the terminal. The special slope limit lines
used by cross section criteria to alter median slopes are also plotted on level 30. 

Locations for guardrail and special slope limit lines are plotted by station and offset to directly
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects. 

Special Requirements: 
End of guardrail beside shoulder / beginning of 50' guardrail curve location must be located 
graphically so that it  can be identified when using program. 

Usage: 

Step 1.	 After establishing additional guardrail coverage needed, draw in guardrail beside 
shoulder to location for beginning of 50' guardrail curve. 

Step 2.	 In D&C manager activate GR Med Br Ends. 

Step 3.	 You are prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 



Step 5.	 You are then prompted for the median width (30'. 36', 48', 60' or 64'). This refers to 
distance between the inside edges of the proposed travel lanes. Pick the appropriate 
width from the list box and click OK. 

Step 6.	 You are then prompted for the guardrail location on the bridge end, Begin (on right 
bridge) or End (on left bridge). Pick the appropriate option from the list box and click 
OK. 

Step 7. Finally you are prompted to Snap & Data end of regular GR. Snap and Data Point 
at the end of the guardrail along the shoulder where the 50' guardrail curve begins. 

All line work is plotted in the file based on the given information. 



GR Med Earth Berm 
D&C location: Drafting Standards> Guardrail> Median GR> GR Med Earth Berm 
Geopak 3PC Program: place_median_earth_berm.x 
Description: 
This application plots in the proposed median earth berm required at the end of bridges. The
quantity of earth required for the berm in cubic yards is calculated and appended to a CSV file
named MedianEarthBerms.csv along with the station and chain of the earth berm. 

This program is based on distances in feet so it is not applicable on metric projects. 

Special Requirements: 
Bridge end locations must be located graphically so that it  can be identified when using 
program. 

Usage: 

Step 1. Locate bridge end locations. 

Step 2. In D&C manager activate GR Med Earth Berm. 

Step 3. You are prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 



Step 5.	 You are then prompted for the median width (30'. 36', 48', 60' or 64'). This refers to 
distance between the inside edges of the proposed travel lanes. Pick the appropriate 
width from the list box and click OK. 

Step 6.	 Next you are prompted to Snap & Data extreme end of BRs. Snap and Data Point 
at the end of the bridge on left or right that is first encountered moving in either 
direction along the roadway centerline. 

Step 7.	 You are then prompted for the median location just given, Begin or End and Left or 
Right (going in the direction of the centerline). Pick the appropriate option from the 
list box and click OK. 

All line work is plotted in the file based on the given information. 



After completion of graphics the quantity of earth required for the berm in cubic 
yards is calculated and appended to a CSV file named MedianEarthBerms.csv along 
with the station and chain of the earth berm which is indicated to user in the following 
message prompt. 

Example of berm earthwork data placed in MedianEarthBerms.csv 
(based on 48' median): 

mainline 259+96.23 68 
mainline 261+48.57 68 
mainline 272+65.15 68 
mainline 274+86.06 68 



GR Med Br Piers 
D&C location: Drafting Standards> Guardrail> Median GR> GR Med Br Piers 
Geopak 3PC Program: place_median_br_pier_prot.x 
Description: 
This application places guardrail from the beginning of the 50' curve through the taper to the
terminal in the median for protection at bridge piers. After setting up the guardrail beside the
shoulder in front of the bridge piers then this program can be utilized to plot in the remaining
guardrail with terminal using the appropriate custom linestyle and terminal end cap. A type text
label is placed for the terminal. The special slope limit lines used by cross section criteria to alter
median slopes are also plotted on level 30. 

Locations for guardrail and special slope limit lines are plotted by station and offset to directly
reflect alignment conditions. 

This program is based on distances in feet so it is not applicable on metric projects. 

Special Requirements: 
End of guardrail beside shoulder / beginning of 50' guardrail curve location must be located 
graphically so that it  can be identified when using program. 

Usage: 

Step 1. Draw in guardrail beside shoulder to location for beginning of 50' guardrail curve. 

Step 2. In D&C manager activate GR Med Br Piers. 

Step 3. You are prompted for a job no. Key that in and click OK. 

Step 4. You are then prompted for the chain name. Key that in and click OK. 



Step 5.	 You are then prompted for the median width (30'. 36', 48', 60' or 64'). This refers to 
distance between the inside edges of the proposed travel lanes. Pick the appropriate 
width from the list box and click OK. 

Step 6.	 You are then prompted for the guardrail location near the bridge pier, Begin (on right 
bridge) or End (on left bridge). Pick the appropriate option from the list box and click 
OK. 

Step 7. Finally you are prompted to Snap & Data end of regular GR. Snap and Data Point 
at the end of the guardrail along the shoulder where the 50' guardrail curve begins. 

All line work is plotted in the file based on the given information. 



After completion of graphics the following warning message is given reminding the 
user that if the roadway is in a curve, the bridges are skewed or if the design 
speed is greater than 60 miles per hour then the guardrail  should be checked for 
adequate coverage of the hazard. 



Traffic Control (Temporary) 
Work Zone Area 
D&C location: Drafting Standards>Traffic Control (Temporary)> Work Zone Area 
Microstation Macro Program: WorkZonePattern.ba 
Description: 
This application sets the parameters needed to pattern a work zone area and places the pattern
using Microstation's Pattern Area Flood by Selection Set or Pattern Area by Element. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Traffic Control - Work Zone or by using the keyin 
MACRO WORKZONEPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.




Erosion Control 
Tmp Slope Drain 
D&C location: Drafting Standards>Erosion Control> EC Devices>Tmp Slope Drain 
Microstation Macro Program: TempSlopeDrain.ba 
Description: 
This application draws a temporary slope drain on the plans at a user specified pipe size with
inlet symbol and optional rip-rap placed at the outlet. 
This macro can also be activated by using the keyin MACRO TEMPSLOPEDRAIN. 

Special Requirements: 
None 
Usage: 

Step 1.	 In D&C manager activate Tmp Slope Drain. The Draw Temporary Slope Drain 
dialog opens. Defaults which are displayed . . . Slope Drain Pipe Size 8", Outlet 
Treatment Place Rip-Rap & Active Scale (current active scale). The active scale 
controls the size of the inlet symbol cell and the outlet rip-rap cell if specified for 
placement. Make settings as needed and click on the Draw Structure button. 

Step 2. You are then prompted to Identify inlet end. Data point at the location for the inlet 
of the temporary slope drain. 



Step 3. You are then prompted to Identify outlet end. Data point at the location for the 
outlet of the temporary slope drain. 

Step 4.	 The temporary slope drain is drawn and the dialog re-appears.  You can click on 
Draw Structure to place another temporary slope drain or click on Cancel to exit the 
program. 



EC Rip-Rap Area 
D&C location: Drafting Standards> Erosion Control> EC Devices> EC Rip-Rap Area 
Microstation Macro Program: ECRipRapPattern.ba 
Description: 
This application sets the parameters needed to pattern an erosion control rip-rap area and places
the pattern using Microstation's Pattern Area Flood by Selection Set or Pattern Area by 
Element. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Erosion Control - Rip-Rap or by using the keyin MACRO ECRIPRAPPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.


BrushSedBarrier 
D&C location: Drafting Standards> Erosion Control> EC Devices> BrushSedBarrier 
Microstation Macro Program: BrushBarrierPattern.ba 
Description: 
This application sets the parameters needed to pattern a brush sediment barrier and places the
pattern using Microstation's Pattern Area Flood by Selection Set or Pattern Area by 
Element. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Erosion Control - Brush Barrier or by using the keyin 
MACRO BRUSHBARRIERPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This item used with D&C Manager's Place influence mode can be used along with Microstation

to define the brush sediment barrier limit with a shape or other elements prior to flooding with

pattern using program.


This option functions just the same as Loss of Access. See the description of it's usage for

details.




Dewatering Stru 
D&C location: Drafting Standards> Erosion Control> EC Devices> Dewatering Stru 
Microstation Macro Program: DewateringPattern.ba 
Description: 
This application sets the parameters needed to pattern a dewatering structure and places the
pattern using Microstation's Pattern Area Flood by Selection Set or Pattern Area by 
Element. 

This macro can also be activated from the Microstation drop down menu TDOT>Area 
Patterns>Erosion Control - Dewatering or by using the keyin 
MACRO DEWATERINGPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This item used with D&C Manager's Place influence mode can be used along with Microstation

to define the dewatering structure limit with a shape or other elements prior to flooding with

pattern using program.


This option functions just the same as Loss of Access. See the description of it's usage for

details.




Construction Supers 
TDOTsuper1 
D&C location: Construction Supers> TDOTsuper1 
Geopak 3PC Program: tdotsup1.x 
Description: 
Adds user specified superelevation data to horizontal  alignment curves. Used by Construction 
personnel. 

Special Requirements: 
All horizontal alignment graphics must be visible in View Window #1. 

Usage: 

Step 1. Using D&C item HA Roadway display the horizontal alignment(s). 

Step 2. In View Window #1 fit view so that all graphics are displayed in the view. If needed 
turn on level 31. 

Step 3. In D&C manager activate TDOTsuper1. 

Step 4. You are prompted for a job no. Key that in and click OK. 

Step 5. You are then prompted for the chain name. Key that in and click OK. 

Step 6. The 3PC processes the chain and finds the first curve. You are first prompted for the 
superelevation rate (e max) for the curve. Key that in and click OK. 



If the curve is a simple curve without spirals: 

Step 7.	 You are then prompted for the transition length for the curve. Key that in and click 
OK. Complex curves with spirals use the spiral length instead of prompting for this 
value. 

Step 8. You are then prompted for the % of the transition on the curve. Key that in and 
click OK. 

If the curve is a complex curve with spirals or when steps 6 through 8 are completed for a 
simple curve: 

Step 9.	 The 3PC processes the chain and looks for additional curves. Depending on the type 
of curve found,  steps 6 through 8 are repeated as needed. On each curve the data 
entered is written to the curve elements. When all curves are processed the chain 
completion message is displayed. 

Once the chain is completed D&C item TDOTsuper2 or TDOTsuper3 can then be 
used. 



TDOTsuper2 
D&C location: Construction Supers> TDOTsuper2 
Geopak 3PC Program: tdotsup2.x 
Description: 
Draws pattern lines with station values at critical superelevation transition points as well as the
begin & end and builds autoshape input file for superelevation using values entered with D&C
item TDOTsuper1. Used by Construction personnel. 

This application is specifically for undivided crown roadways. 

Special Requirements: 
Superelevation information must be written to horizontal alignment graphics with D&C item

TDOTsuper1.


Usage:


Step 1. Using D&C item TDOTsuper1 to set up superelevation information.


Step 2. In D&C manager activate TDOTsuper2.


Step 3. You are prompted for a job no. Key that in and click OK.


Step 4. You are then prompted for the chain name. Key that in and click OK. 

Step 5. You are then prompted for the profile name. Key that in and click OK. 



Step 6. You are then prompted for the Horizontal Distance between Chain and Profile. 
Key that in and click OK. 

This is referring to the tie offset which is usually 0 for undivided crown roadways 
which is the default value given. 

Step 7.	 You are then prompted for the Left Offset which is used to define the outside limit of 
the superelevation shape to the left. Key that in and click OK. 

Offsets to the left of the centerline are always negative numbers. 

Step 8.	 You are then prompted for the Right Offset which is used to define the outside limit 
of the superelevation shape to the right. Key that in and click OK. 

Step 9. You are then prompted for the Autoshape File Name. This is the superelevation 
shape input file the program is to create. Key that in and click OK. 

Step 10. You are then given the option to place patterns where the outside slope = 0.000 (zero 
slope). Pick Yes or No and click OK. 



Step 11. Finally you are prompted for the Microstation DGN filename that supershapes are to 
be written into. Key in the filename and click OK.. 

The pattern lines are drawn and annotated with station values in the open 
Microstation DGN file. 

The autoshape input file is created and can be reviewed with any text editor. If 
desired, transitions back to existing cross slopes can be added at the ends by editing 
station and cross slopes listed. Note that cross slopes must be in a percentage format. 

Geopak's Autoshape Builder can now be used to process this input file to build 
superelevation shapes for the roadway. 



TDOTsuper3 
D&C location: Construction Supers> TDOTsuper3 
Geopak 3PC Program: tdotsup3.x 
Description: 
Draws pattern lines with station values at critical superelevation transition points as well as the
begin & end and builds autoshape input file for superelevation using values entered with D&C
item TDOTsuper1. Used by Construction personnel. 

This application is specifically for divided roadways or ramps. 

Special Requirements: 
Superelevation information must be written to horizontal alignment graphics with D&C item
TDOTsuper1. 

This program must be run twice to set up autoshape input files for left & right side of divided 
highways. 

In most cases it is only necessary to run once to the left for ramps. 

Usage:


Step 1. Using D&C item TDOTsuper1 to set up superelevation information.


Step 2. In D&C manager activate TDOTsuper3.


Step 3. You are prompted for a job no. Key that in and click OK.


Step 4. You are then prompted for the chain name. Key that in and click OK. 

Step 5. You are then prompted for the profile name. Key that in and click OK. 



Step 6. You are then prompted for the Offset to the inside edge of pavement or PGL 
(profile grade line). Key that in and click OK. 

Normally for ramps… this value would be 0. All other offsets to the left of the 
centerline are always negative numbers. 

Step 7.	 You are then prompted for the Offset to the outside edge of pavement which is used 
to define the outside limit of the superelevation shape. Key that in and click OK. 

Step 8. You are then prompted for the Normal Crown slope. This must be entered in a 
percentage format such as -2. Key that in and click OK. 

Normally for ramps… this value would be a positive 2 percent (i.e. 2). Only in 
special cases where ramp supelevation shapes are set up to the right would this value 
be -2. 

Step 9.	 You are then prompted for the Autoshape File Name. This is the superelevation 
shape input file the program is to create. Key that in and click OK. 

On the second pass for the opposite side of the road, keyin a different filename than 
entered on the first pass to avoid overwriting the first file (i.e. shape2.inp). 



Step 10. You are then given the option to Draw Patterns?. Pick Yes or No and click OK. 

On the first pass using this program you would normally say Yes and on the second 
pass to set up the other side of the divided roadway you would say No having already 
placed patterns. 

Step 11.	 If you said Yes to place patterns then you are then given the option to place patterns 
where the outside slope = 0.000 (zero slope). Pick Yes or No and click OK. 

Step 12. Finally you are prompted for the Microstation DGN filename that superelevation 
shapes are to be written into. Key in the filename and click OK.. 

If the pattern line option was chosen then they are drawn and annotated with station 
values in the open Microstation DGN file. 



The autoshape input file is created and can be reviewed with any text editor. If 
desired, transitions back to existing cross slopes can be added at the ends by editing 
station and cross slopes listed. Note that cross slopes must be in a percentage format. 

Geopak's Autoshape Builder can now be used to process this input file to build 
superelevation shapes for one side of the roadway or you may wish to run this 
program again to set up the opposite side of the roadway and then process both 
autoshape input files at the same time. 

Step 13. Repeat steps 2 through 12 to set up the opposite side of  a divided highway. 



Functional 
HA Points F 
D&C location: Drafting Standards>Prop. Drainage>Special Ditches> HA Points F 
Geopak 3PC Program: draw_func_horiz_points.x 
Description: 
Uses text symbol characters to mark all points on functional horizontal alignments. 

Special Requirements: 
All alignment graphics must be visible in View Window #1. 

Usage: 
This option functions just the same as HA Points. See the description of it's usage for details. 

Pvmt Pattern F 
D&C location: Functional> Pvmt Pattern F 
Microstation Macro Program: FuncPvmtPattern.ba 
Description: 
This application sets the parameters needed to pattern a functional pavement area and places the
pattern using Microstation's Pattern Area Flood by Selection Set or Pattern Area by 
Element. 

This macro can also be activated by using the keyin MACRO FUNCPVMTPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.




Br Pattern F 
D&C location: Functional> Br Pattern F 
Microstation Macro Program: FuncBrPattern.ba 
Description: 
This application sets the parameters needed to pattern a functional bridge area and places the
pattern using Microstation's Pattern Area Flood by Selection Set or Pattern Area by 
Element. 

This macro can also be activated by using the keyin MACRO FUNCBRPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.


ROW Pattern F 
D&C location: Functional> ROW Pattern F 
Microstation Macro Program: FuncROWPattern.ba 
Description: 
This application sets the parameters needed to pattern a functional R.O.W. area and places the
pattern using Microstation's Pattern Area Flood by Selection Set or Pattern Area by 
Element. 

This macro can also be activated by using the keyin MACRO FUNCROWPATTERN. 

Special Requirements: 
Depending on the mode of area pattern placement to be used take the following actions: 

Selection Set Flood mode: Create Selection Set prior to activating macro 

Shape Element mode: Create shape element prior to activating macro 

Usage:

This option functions just the same as Loss of Access. See the description of it's usage for

details.




Pay Items 
R.O.W.

ROW Markers

D&C location: Pay Items> R.O.W.> ROW Markers 
Geopak 3PC Program: count_row_markers.x 
Description: 
This application reads a selection set of a given sheet area & then counts all R.O.W. markers and
appends this info to a CSV file named ROWmarkers.csv. 

Data in the file reads sheet no., number of A's, number of B's, number of C's. 

Special Requirements: 
Microstation selection set which includes graphics from level 46 must be active. 

Usage: 

Step 1.	 Turn on level 46 if not already on. Create a Microstation selection set of elements for 
the first sheet area. 

Step 2.	 In D&C manager activate ROW Markers. 

Step 3.	 You are prompted for the sheet no. Key that in and click OK. 

Step 4.	 The selection set is processed and graphics are read looking for proposed R.O.W. 
marker cells (PROWA, PROWB & PROWC). When processing is finished the 
numbers are totaled and appended to CSV file ROWmarkers.csv .Click OK to 
dismiss the completion message. 



Step 5.	 Repeat steps 1 through 4 for the remaining sheet areas. At any time Excel can be used 
to review the contents of the CSV data file being built. Remember the data in the file 
reads sheet no., number of A's, number of B's, number of C's. 

Step 6.	 When all sheets have been counted, open ROWmarkers.csv with Excel, highlight all 
the data and click Copy. Open your projects estimated roadway quantities Excel file 
to your R.O.W. markers tabulation worksheet. Use Insert to add this worksheet if 
needed. Click into the first field of the block, right click choose Paste Special, set to 
Values and click OK to paste the data into the block. 
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